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LÍNGUA PORTUGUESA 
 

A MISÉRIA É DE TODOS NÓS 
 

Como entender a resistência da miséria no Brasil, 
uma chaga social que remonta aos primórdios da 
colonização? No decorrer das últimas décadas, 
enquanto a miséria se mantinha mais ou menos do 
mesmo tamanho, todos os indicadores sociais 
brasileiros melhoraram. Há mais crianças em idade 
escolar freqüentando aulas atualmente do que em 
qualquer outro período da nossa história. As taxas 
de analfabetismo e mortalidade infantil também são 
as menores desde que se passou a registrá-las 
nacionalmente. O Brasil figura entre as dez nações 
de economia mais forte do mundo. No campo 
diplomático, começa a exercitar seus músculos. Vem 
firmando uma inconteste liderança política regional 
na América Latina, ao mesmo tempo que atrai a 
simpatia do Terceiro Mundo por ter se tornado um 
forte oponente das injustas políticas de comércio dos 
países ricos. Apesar de todos esses avanços, a 
miséria resiste. 

Embora em algumas de suas ocorrências, 
especialmente na zona rural, esteja confinada a 
bolsões invisíveis aos olhos dos brasileiros mais bem 
posicionados na escala social, a miséria é 
onipresente. Nas grandes cidades, com aterrorizante 
freqüência, ela atravessa o fosso social profundo e 
se manifesta de forma violenta. A mais assustadora 
dessas manifestações é a criminalidade, que, se não 
tem na pobreza sua única causa, certamente em 
razão dela se tornou mais disseminada e cruel. 
Explicar a resistência da pobreza extrema entre 
milhões de habitantes não é uma empreitada 
simples.  

      Veja, ed. 1735 
 
 
01 - O título dado ao texto se justifica porque: 
 
(A) a miséria abrange grande parte de nossa 

população; 
(B) a miséria é culpa da classe dominante; 
(C) todos os governantes colaboraram para a 

miséria comum; 
(D) a miséria deveria ser preocupação de todos 

nós; 
(E) um mal tão intenso atinge indistintamente a 

todos. 
 
 

02 - A primeira pergunta – “Como entender a 
resistência da miséria no Brasil, uma chaga social 
que remonta aos primórdios da colonização?”: 
 
(A) tem sua resposta dada no último parágrafo; 
(B) representa o tema central de todo o texto; 
(C) é só uma motivação para a leitura do texto; 
(D) é uma pergunta retórica, à qual não cabe 

resposta; 
(E) é uma das perguntas do texto que ficam sem 

resposta. 
 
 
03 - Após a leitura do texto, só NÃO se pode dizer da 
miséria no Brasil que ela: 
 
(A) é culpa dos governos recentes, apesar de 

seu trabalho produtivo em outras áreas; 
(B) tem manifestações violentas, como a 

criminalidade nas grandes cidades; 
(C) atinge milhões de habitantes, embora alguns 

deles não apareçam para a classe 
dominante; 

(D) é de difícil compreensão, já que sua 
presença não se coaduna com a de outros 
indicadores sociais;  

(E) tem razões históricas e se mantém em níveis 
estáveis nas últimas décadas. 

 
 
04 - O melhor resumo das sete primeiras linhas do 
texto é: 
 
(A) Entender a miséria no Brasil é impossível, já 

que todos os outros indicadores sociais 
melhoraram; 

(B) Desde os primórdios da colonização a 
miséria existe no Brasil e se mantém 
onipresente; 

(C) A miséria no Brasil tem fundo histórico e foi 
alimentada por governos incompetentes; 

(D) Embora os indicadores sociais mostrem 
progresso em muitas áreas, a miséria ainda 
atinge uma pequena parte de nosso povo; 

(E) Todos os indicadores sociais melhoraram 
exceto o indicador da miséria que leva à 
criminalidade. 
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05 - As marcas de progresso em nosso país são 
dadas com apoio na quantidade, exceto: 
 
(A) freqüência escolar; 
(B) liderança diplomática; 
(C) mortalidade infantil; 
(D) analfabetismo; 
(E) desempenho econômico. 
 
 
06 - “No campo diplomático, começa a exercitar 
seus músculos.”; com essa frase, o jornalista quer 
dizer que o Brasil: 
 
(A) já está suficientemente forte para começar a 

exercer sua liderança na América Latina; 
(B) já mostra que é mais forte que seus países 

vizinhos; 
(C) está iniciando seu trabalho diplomático a fim 

de marcar presença no cenário exterior; 
(D) pretende mostrar ao mundo e aos países 

vizinhos que já é suficientemente forte para 
tornar-se líder; 

(E) ainda é inexperiente no trato com a política 
exterior. 

 
 
07 - Segundo o texto, “A miséria é onipresente” 
embora: 
 
(A) apareça algumas vezes nas grandes cidades; 
(B) se manifeste de formas distintas; 
(C) esteja escondida dos olhos de alguns; 
(D) seja combatida pelas autoridades; 
(E) se torne mais disseminada e cruel. 
 
 
08 - “...não é uma empreitada simples” equivale a 
dizer que é uma empreitada complexa; o item em 
que essa equivalência é feita de forma INCORRETA 
é: 
 
(A) não é uma preocupação geral = é uma 

preocupação superficial;  
(B) não é uma pessoa apática = é uma pessoa 

dinâmica; 
(C) não é uma questão vital = é uma questão 

desimportante; 
(D) não é um problema universal = é um 

problema particular;  
(E) não é uma cópia ampliada = é uma cópia 

reduzida. 

09 - “...enquanto a miséria se mantinha...”; 
colocando-se o verbo desse segmento do texto no 
futuro do subjuntivo, a forma correta seria: 
 
(A) mantiver; 
(B) manter; 
(C) manterá; 
(D) manteria; 
(E) mantenha. 
 
 
10 - A forma de infinitivo que aparece substantivada 
nos segmentos abaixo é: 
 
(A) “Como entender a resistência da miséria...”; 
(B) “No decorrer das últimas décadas...”; 
(C) “...desde que se passou a registrá-las...”; 
(D) “...começa a exercitar seus músculos.”; 
(E) “...por ter se tornado um forte oponente...”. 
 
 

LÍNGUA INGLESA 
 

READ TEXT I AND ANSWER QUESTIONS 11 TO 14: 
 

The right to drive or the right to breathe? 
 

       Politicians have taken some steps to cut 
deaths from dirty air, but more are needed. 

  In 1554, a band of wandering Jesuits, after 
sweating through southern Brazil’s forested 
coastal hills, stopped by a river on the high 
Piratininga plateau and, delighted at its fresh, cool 
air, founded the city of São Paulo. Were they to 
return now, for much of the year they would find a 
grey-brown smog shrouding a metropolis of 18m 
people and 6m vehicles. The foul air kills 
thousands of people a year and inflicts chronic 
illness on countless others. 
  Mexico city has long been notorious for its 
polluted air. Fuel burns less efficiently at high 
altitudes, and thermal inversions mean that the 
surrounding mountains trap a layer of cold air 
above the city, preventing the dispersal of fumes. 
But the surge in car ownership throughout Latin 
America since the 1970s means that São Paulo 
and other Latin American capitals are no longer 
far behind. Though at lower altitudes, both São 
Paulo and Santiago suffer from thermal 
inversions, too. 

 
(http://www.cnn.com/2001/TECH/science/) 
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11 - According to the text, the air in São Paulo is: 
 
(A) pleasant; 
(B) harmless; 
(C) unclean; 
(D) pure; 
(E) unkind. 
 
 
12 - The pollution in São Paulo has worsened 
because of:   
 
(A) an increase in car sales; 
(B) the dispersal of polluting fumes; 
(C) too little fuel burning; 
(D) generalised global warming; 
(E) local government policies. 
 
 
13 - In “more are needed” (l.02), the word that has 
been omitted is: 
 
(A) deaths;  
(B) steps; 
(C) politicians; 
(D) vehicles; 
(E) Jesuits. 
 
 
14 - Preventing in “preventing the dispersal of 
fumes” (l.17) can be replaced by:  
 
(A) avoiding; 
(B) stopping;  
(C) forbidding; 
(D) providing; 
(E) causing. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

READ TEXT II AND ANSWER QUESTIONS 15 TO 20: 
 

ON THE GROUND FOR CHILDREN IN POVERTY 
 

That’s where World Vision is making a world of 
difference 

 
   World Vision is there on the spot in 90 

countries, working with communities to find 
solutions to disaster and poverty. 
  Nearly 2 million sponsors are linked with 
children in the world’s  poorest countries through 
World Vision Child Sponsorship. 
  We work hand in hand with local 
communities and families to identify their needs 
and work together to bring about long term 
improvement. 
  Being there makes the world of difference. 
In time. In human lives. In effectiveness. Whether 
it’s providing health care, education, clean water, 
food security through agricultural teachers or 
developing local leadership. 

 
(Newsweek, July 30, 2001:51) 

 
15 - The aim of the organisation is to: 
 
(A) encourage continuous development; 
(B) disregard human qualities; 
(C) emphasise local  individualities; 
(D) disrupt sanitary conditions; 
(E) promote individual recognition. 
 
 
16 - The organisation’s working strategy is to: 
 
(A) impose some conditions; 
(B) send food supplies; 
(C) hand out money; 
(D) help the rich; 
(E) take joint decisions. 
 
 
17 - The opposite of  “poverty” in  “find solutions to 
disaster and poverty” (l.03) is:    
 
(A) rich; 
(B) wealth; 
(C) healthy; 
(D) richest; 
(E) wealthier. 
 

05 
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18 - The underlined word in “Nearly 2 million 
sponsors are linked with children” (l.04) has the same 
meaning as: 
 
(A) Nearby; 
(B) Among; 
(C) None; 
(D) Almost; 
(E) Nevertheless. 
 
 
19 - The noun form which corresponds to long in 
“long term improvement” (l.09) is: 
 
(A) longer; 
(B) long-standing; 
(C) longish; 
(D) longest; 
(E) length. 
 
 
20 - The place that “being there” (l.11) refers to is: 
 
(A) two million homes; 
(B) leaders’ workplaces; 
(C) needy areas; 
(D) educated households; 
(E) large health centres.  
 

ANÁLISE DE SISTEMAS 
 
21- Considere as seguintes assertivas sobre regras de 
consistência entre um processo de um DFD e sua mini-
especificação: 

 
I. os fluxos de entrada no processo devem 

aparecer na mini-especificação em operações 
de leitura; 

II. os fluxos de saída não devem aparecer na 
mini-especificação em operações de escrita; 

III. somente os fluxos de saída devem aparecer na 
mini-especificação; 

IV. somente os fluxos de entrada devem aparecer 
na mini-especificação; 

V. todos os fluxos do diagrama devem aparecer 
na mini-especificação.  

 
As assertivas corretas são: 

 
(A) somente I e II 
(B) somente I e III 
(C) somente II e III 
(D) somente III e IV 
(E) somente V 

22 - Considere as seguintes assertivas sobre as regras de 
consistência do modelo ambiental de um sistema de 
informação: 

 
I. cada um dos fluxos de entrada do diagrama de 

contexto deve ser utilizado pelo sistema para 
reconhecer um evento, ou produzir uma saída, 
ou ambos. 

II. cada um dos fluxos de saída deve fazer parte 
da resposta a um evento 

III. a detecção de todo evento não-temporal deve 
estar associada a pelo menos um fluxo de 
entrada 

 
As assertivas corretas são: 

 
(A) somente I; 
(B) somente II; 
(C) somente I e II; 
(D) somente I e III; 
(E) I e II e III. 

 
 

23 - Considere as seguintes assertivas sobre o diagrama de 
classes na notação UML: 

 
I. uma classe representa um conjunto de objetos 

cuja cardinalidade é sempre maior do que um. 
II. o polimorfismo das operações é uma 

conseqüência da relação de herança entre 
classes. 

III. se um objeto A está associado a um objeto B e 
B está associado a mais de um objeto C então, 
obrigatoriamente, um objeto C estará 
associado a mais de um objeto ª 

 
As assertivas corretas são: 

 
(A) somente I; 
(B) somente II; 
(C) somente III; 
(D) somente I e II; 
(E) somente II e III. 

 
 
 
 
 
 
 
 

24 - Um diagrama ER tem por objetivo: 
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(A) modelar os aspectos estáticos de uma estrutura de 

dados;  
(B) modelar os aspectos dinâmicos de uma estrutura de 

dados, inclusive as transições entre estados 
consistentes; 

(C) modelar as transações suportadas por uma estrutura 
de dados; 

(D) modelar  o diagrama de estados de um sistema; 
(E) modelar os dados migrados em sistemas 

distribuídos. 
 
 
25 - Para bancos de dados relacionais, a forma normal que 
determina que, numa tabela, todo determinante deve ser 
uma chave, primária ou candidata, é a: 
 
(A) primeira; 
(B) segunda; 
(C) terceira; 
(D) quarta; 
(E) Boyce-Codd. 
 

 
26 - A arquitetura ANSI/SPARC para gerenciadores de 
bancos de dados divide-se em três níveis principais, que 
são: 

 
(A) conceitual, externo, interno; 
(B) lógico, interno, físico; 
(C) lógico, conceitual, visão; 
(D) conceitual, lógico, visão; 
(E) estruturas, dados, índices. 
 
 
27 - Sistemas gerenciadores de bancos de dados 
categorizam-se em três grandes grupos, de acordo com sua 
abordagem na construção. Estes grupos são: 
 
(A) hierárquico, rede, relacional; 
(B) centralizado, distribuído, replicado; 
(C) batch, online, tempo real; 
(D) um nível, dois níveis, três níveis; 
(E) cliente/servidor, cliente/cliente, servidor central. 
 
 
 
 
 
 

28 - No contexto de bancos de dados, entende-se por 
dicionário de dados: 
 
(A) as estruturas de índices; 
(B) índices implementados sobre texto livre; 
(C) o conjunto de dados armazenados no banco de 

dados; 
(D) as estruturas e dados que servem para descrever o 

banco de dados; 
(E) o glossário de comandos da implementação. 
 
 
29 - As anomalias de atualização, passíveis de ocorrer 
quando múltiplos usuários acessam concomitantemente 
bases de dados comuns, são evitadas nos sistemas 
gerenciadores de bancos dados por controles operacionais 
conhecidos como: 
 
(A) lock compartilhado; 
(B) independência de dados; 
(C) controle de concorrência; 
(D) recuperação de dados; 
(E) sistemas de replicação. 
 
 
30 - No contexto de bancos de dados, índices são melhor 
definidos como: 
 
(A) blocos de espaço em disco que são alocados 

esporadicamente; 
(B) indicadores de performance, utilizados para fazer 

o tuning da implementação; 
(C) estruturas de dados auxiliares que permitem a 

rápida localização de registros específicos; 
(D) indicadores do número de registros em cada 

arquivo, permitindo a otimização dos planos de 
execução de consultas genéricas; 

(E) fatores de espalhamento dos valores presentes em 
um dados campos de um arquivo.  
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31 - Suponha que se deseja modelar os dados elementares 
de um colégio, com as entidades alunos, turmas, matérias e 
professores. As turmas são grupos de alunos e cada aluno 
pertence a somente uma turma.  Cada professor ministra a 
mesma matéria em uma ou mais turmas.  Uma turma 
recebe aulas de várias matérias.  Não há mais de um 
professor por matéria.  Com referência aos tipos de 
relacionamentos que ocorrem entre estas entidades, 
considere os pares: 
 

Entidade Entidade Tipo de 
Relacionamento

Professor Aluno ? 
Aluno Turma ? 

Matéria Professor ? 
Turma Matéria ? 

 
Para cada par de entidades apresentadas, o tipo de 
relacionamento é, respectivamente: 
 
(A) N:M, N:1, 1:1, N:M 
(B) 1:N, 1:1, 1:1, N:M 
(C) N:M, N:1, 1:N, N:M 
(D) N:M, 1:1, 1:1, N:M 
(E) N:M, N:1, 1:1, 1:N 
 
 
32 - Em relação à tecnologia de orientação a objetos, a 
afirmativa de que o estado de um objeto não deve ser 
acessado diretamente, mas sim por intermédio de métodos 
de acesso (ou propriedades) está diretamente relacionada 
ao conceito de: 
 
(A) herança; 
(B) interface; 
(C) classe; 
(D) polimorfismo; 
(E) encapsulamento. 
 
 
33 - Em ambiente de objetos distribuídos, a habilidade de 
troca de mensagens entre objetos com a finalidade de 
permitir que objetos requisitem serviços de outros objetos, 
cooperativamente, independente de suas diferenças 
internas (como diferentes plataformas de hardware, 
sistemas operacionais e modelo de dados) é denominada: 
 
(A) interoperabilidade; 
(B) replicação; 
(C) integração; 
(D) tratamento de erro; 
(E) orientação a objetos. 

34 - Em relação às tecnologias de middleware baseadas na 
metáfora de filas (message and queuing middleware), é 
INCORRETO afirmar que:  
 
(A) É possível filtrar as mensagens antes do seu 

processamento; 
(B) É possível enviar mensagens mesmo na presença 

de falhas na rede; 
(C) É possível enviar mensagens para vários 

destinatários; 
(D) É possível intercambiar mensagens de forma 

assíncrona; 
(E) É possível enviar e transmitir mensagens de forma 

síncrona.  
 
 
35 - O protocolo de comunicação padrão da internet 
(World Wide Web) é o:  
 
(A) HTML; 
(B) XML; 
(C) HTTP; 
(D) DCOM; 
(E) CORBA. 
 
 
36 - O sistema operacional OS/390 gerencia três níveis de 
memória: memória central, memória expandida e arquivos 
de paginação em discos. A memória central tem a seguinte 
organização: 
 
(A) páginas com tamanho de 32K, cada uma; 
(B) páginas com tamanho de 4K, cada uma; 
(C) partições com tamanho de 1M, cada um; 
(D) segmentos com tamanho de 8K, cada um; 
(E) Cache de 2GB. 
 
 
37 - NTFS, FAT e FAT32 são siglas que se referem a: 

 
(A) sistemas de arquivos; 
(B) protocolos de rede; 
(C) scripts de login; 
(D) dispositivos de hardware; 
(E) politicas de grupo. 
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38 - Num computador executando Windows 2000 
Professional, para que um usuário possa desempenhar 
todas as funções administrativas, ele deve pertencer ao 
seguinte grupo local: 

 
(A) Administrators; 
(B) Backup operators; 
(C) Power users; 
(D) Users; 
(E) Replicators. 

 
 

39 - Ao configurar as propriedades de uma conexão de 
rede com protocolo TCP/IP, um dos atributos que devem 
ser informados é o “Default Gateway”. A função deste 
atributo é definir: 

 
(A) o endereço IP do roteador usado para encaminhar 

o tráfego destinado a endereços fora da rede local; 
(B) os endereços que não podem ser acessados pelo 

computador local; 
(C) o servidor DNS que será utilizado pelo 

computador; 
(D) a máscara de sub-rede utilizada para alterar o 

funcionamento das classes de endereços; 
(E) o IP do servidor de domínio utilizado para 

autenticar este computador na rede Windows 
2000. 

 
 

40 - Para verificar a atividade de um outro computador na 
rede local, isto é, se ele está respondendo a solicitações da 
rede, o comando que poderia ser usado em um Windows 
2000 Server é: 

 
(A) CONNECT 
(B) NETC 
(C) PING 
(D) NETADM 
(E) MASK 

 
 

 
 
 
 
 
 
 

ANÁLISE DE SISTEMAS/DESENVOLVIMENTO 
WEB E WEBDESIGNER 

 

Nas questões 41 e 42 considere o modelo E-R abaixo:  
 

 
 
41 - De acordo com a modelagem acima pode-se afirmar 
que: 
 

I. Um livro pode pertencer a duas bibliotecas. 
II. Um usuário pode pegar emprestado 5 livros. 
III. Uma pessoa pode pegar livros de mais de uma 

biblioteca. 
IV. Um livro pode ser emprestado para mais de um 

usuário. 
 
A alternativa que contém somente afirmativas verdadeiras 
é: 
 
(A) I e II; 
(B) I e III; 
(C) II e  III; 
(D) II e IV; 
(E) III e IV. 
 
 
42 - De acordo com a modelagem apresentada, pode-se 
afirmar que: 
 

I. Uma pessoa pode estar cadastrada em várias 
bibliotecas. 

II. Uma pessoa deve estar cadastrada em pelo 
menos uma biblioteca.  

III. Uma biblioteca tem pelo menos um usuário. 
IV. Uma biblioteca tem pelo menos um livro. 

 
A alternativa que contém somente afirmativas verdadeiras 
é: 
 
(A) I e II; 
(B) I e III; 
(C) II e  III; 
(D) II e IV; 
(E) III e IV. 

 
 
 

43 - Na 2a Forma Normal os atributos não-chave 
dependem: 
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(A) de atributos chave; 
(B) de atributos em chaves estrangeiras; 
(C) de atributos mono-valorados; 
(D) de atributos multi-valorados; 
(E) de atributos não-chave. 
 
 
44 - Considere que, no MS SQL Server 7.0, uma tabela 
possua um registro que contém, nas suas cinco colunas, os 
seguintes valores: 

 
   1234567 
   SIMPLEX 
   3 

33.06 
   12/3/1892 15:10:08 
 

Tomando-se por base estes valores, os tipos de dados mais 
adequados para os atributos da referida tabela são, na 
ordem: 
 
(A) int, varchar, tinyint, decimal, datetime; 
(B) long, varchar,double, tinyint, smalldatetime; 
(C) single, string, smallint, doublereal, datetime; 
(D) int, string, integer, real, time; 
(E) long, string, int, single, date.  
 
 
45 - No ADABAS, as opções apropriadas para a 
especificação de campos identificadores são: 
 
(A) NC, NN: 
(B) DE, UQ; 
(C) FI, NU; 
(D) MU, PE; 
(E) FI, LA; 
 
 
 
 
 
 
 
 
 
 
 
 
Nas questões 46 e 47 considere as seguintes relações e suas 
instâncias. 

 
T1 

X Y 
4 5 
6 9 
3 3 
2 9 
0 2 
 
T2 
Y Z 
3 8 
7 5 
1 2 
 
 

46 - Após a execução do comando SQL 
 

UPDATE  T2 
Set T2.Z=T2.Z + T2.Y 
WHERE  
  (SELECT count(*) FROM T1 WHERE T1.Y < T2.Y) >0 
 

os registros da tabela T2 ficam sendo: 
 
(A) <3,11> <7,12> <1,3> 
(B) <3,8> <7,5> <1,3> 
(C) <3,11> <7,5> <0,2> 
(D) <3,11> <7,12> <1,2> 
(E) <3,8> <7,12> <0,2> 
 
 
47 - Após a execução do comando SQL 
 
DELETE FROM T2 WHERE NOT EXISTS(SELECT *  FROM T1 T 
WHERE T.X=T2.Z) 
 
os registros da tabela T2 ficam sendo: 
 
(A) <3,8> <7,5> <1,2> 
(B) <3,8> <1,2> 
(C) <1,2> 
(D) <3,8> <7,5> 
(E) <7,5> <1,2> 
 
 
 
 
 
 
48 - Considere a seguinte lista de elementos: 
 

I. identificação do servidor SQL (IP ou nome) 
II. porta de entrada na máquina servidora 
III. identificação da máquina cliente (IP ou nome) 
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IV. identificação do agente de atendimento SQL 
no servidor 

Para a definição de um Data Source Name, tendo-se por 
alvo um banco de dados MS SQL Server, além do nome do 
banco de dados, é necessário especificar pelo menos: 
 
(A) I;  
(B) I, II, III; 
(C) I, IV; 
(D) II, IV; 
(E) I, II. 
 
 
49 - Dentre as opções abaixo, assinale a seqüência de 
marcações HTML utilizada para construir a tabela a seguir 
(extraída de uma página HTML visualizada através de um 
browser MS-IE 6.0). 
 

DEF ABC 
GHI JLM 

NO
P 

QR
S TUV Xza 

 
(A)  

<table border> 
 <tr> 
  <th rows=2 cols=2>ABC</th> 
  <th cols=2>DEF</th> 
 </tr> 
 <tr> 
  <th>GHI</th> 
  <th>JLM</th> 
 </tr> 
 <tr> 
  <td>NOP</td> 
  <td>QRS</td> 
  <td>TUV</td> 
  <td>XZa</td> 
 </tr> 
</table> 

 
(B)  

<table border> 
 <tr> 
  <th rowspan=2 colspan=2>ABC</th> 
  <th colspan=2>DEF</th> 
 </tr> 
 <tr> 
  <th>GHI</th> 
  <th>JLM</th> 
 </tr> 
 <tr> 
  <td>NOP</td> 
  <td>QRS</td> 
  <td>TUV</td> 
  <td>XZa</td> 
 </tr> 
</table> 

(C)  
<table border> 
 <tr> 
  <th vspace=2 hspace=2>ABC</th> 
  <th hspace=2>DEF</th> 

 </tr> 
 <tr> 
  <th>GHI</th> 
  <th>JLM</th> 
 </tr> 
 <tr> 
  <td>NOP</td> 
  <td>QRS</td> 
  <td>TUV</td> 
  <td>XZa</td> 
 </tr> 
</table> 

 
(D)  

<table border> 
 <tr> 
  <th style=’width:2; heigth:2;’>ABC</th> 
  <th style=’width:2;’>DEF</th> 
 </tr> 
 <tr> 
  <th>GHI</th> 
  <th>JLM</th> 
 </tr> 
 <tr> 
  <td>NOP</td> 
  <td>QRS</td> 
  <td>TUV</td> 
  <td>XZa</td> 
 </tr> 
</table> 

 
(E)  

<table border> 
 <tr> 
  <th>ABC</th> 
  <th>DEF</th> 
  <th valid=null></th> 
  <th valid=null></th> 
 </tr> 
 <tr> 
  <th>GHI</th> 
  <th>JLM</th> 
  <th valid=null></th> 
  <th valid=null></th> 
 </tr> 
 <tr> 
  <td>NOP</td> 
  <td>QRS</td> 
  <td>TUV</td> 
  <td>XZa</td> 
 </tr> 
</table> 

 
 
 
 
 
 
 
 
 
 
 
50 - Considere o seguinte formulário como sendo o único 
em uma página HTML visualizada por um browser: 
 

<form name=formulario> 
 Texto: <input type='text' name='fruta'><br> 
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 <input type='button' 
onClick='mostra()' 
name=’Mostra’ 
value='Mostra'> 

</form> 

 
O código em Javascript que irá mostrar o conteúdo do 
campo texto do formulário quando o botão “Mostra” for 
pressionado é: 
 
(A)  

<script language='javascript'> 
function mostra() 
{ 
 alert (document.formulario.fruta); 
} 
</script> 

 
(B)  

<script language='javascript'> 
function mostra() 
{ 
 alert 
(window.document.formulario.fruta.content); 
} 
</script> 

 
(C)  

<script language='javascript'> 
function mostra() 
{ 
 alert (fruta.value); 
} 
</script> 

 
(D)  

<script language='javascript'> 
function mostra() 
{ 
 alert (window.fruta.value); 
} 
</script> 

 
(E)  

<script language='javascript'> 
function mostra() 
{ 
 alert 
(window.document.formulario.fruta.value); 
} 
</script> 

 
 
 
 
 
 
 
 
51 - Considere o comando ASP mostrado a seguir: 
 

<% Option Explicit %> 
 

A finalidade deste comando é: 

 
(A) explicitar que a linguagem de script que será 

utilizada é a linguagem opcional do servidor onde o 
site está hospedado; 

(B) obrigar o programador a declarar explicitamente 
todas as opções de execução do script no servidor; 

(C) permitir que o código ASP seja revelado para o 
usuário através do seu browser; 

(D) tornar obrigatória a declaração de todas as 
variáveis; 

(E) tornar opcional a declaração de funções. 
 
 
52 - O formulário abaixo foi enviado através de um 
browser para uma página ASP hospedada em um servidor 
IIS: 
 

<form action=’pagina.asp’ name=’formulario’> 
 Texto: <input type='text' name='fruta'><br> 
 <input type='button' onClick='mostra()'> 
</form> 

 
O código nesta página que irá obter o conteúdo do campo 
texto será: 
 
(A) formulario.fruta.value 
(B) request.form (“fruta”) 
(C) response.read (“fruta”) 
(D) session (“fruta”) 
(E) window.document.formulario.fruta 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
O documento XML a seguir contém um XML Schema. 
Considere este documento nas questões 53 e 54.  

 
<xsd:schema   
   xmlns:xsd="http://www.w3.org/2001/XMLSchema”>  
  <xsd:element name="book"> 
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    <xsd:complexType> 
      <xsd:sequence> 
        <xsd:element ref="title" /> 
        <xsd:element ref="author"  
           minOccurs="1"  
           maxOccurs="unbounded" /> 
      </xsd:sequence> 
    </xsd:complexType> 
  </xsd:element> 
  <xsd:element name="author"> 
    <xsd:complexType> 
      <xsd:sequence> 
        <xsd:element ref="name" /> 
        <xsd:element ref="email" /> 
      </xsd:sequence> 
    </xsd:complexType> 
  </xsd:element> 
  <xsd:element name="name"> 
    <xsd:complexType> 
      <xsd:sequence> 
        <xsd:element ref="firstname" /> 
        <xsd:element ref="lastname" /> 
      </xsd:sequence> 
    </xsd:complexType> 
  </xsd:element> 
  <xsd:element name="title"  
   type="xsd:string"/> 
  <xsd:element name="email"  
   type="xsd:string"/> 
  <xsd:element name="firstname"  
   type="xsd:string"/> 
  <xsd:element name="lastname"  
   type="xsd:string"/> 
</xsd:schema> 

 
 
53 - A alternativa que apresenta trechos de documentos XML 
válidos de acordo com o XML Schema acima é: 
 
(A)  
<book> 
 <title>Janelas do Ciberespaco</title> 
 <author> 
  <name firstname = “Andre” lastname= “Lemos” /> 
  <email>alemos@yahoo.com</email> 
 </author> 
</book> 

(B) 
<book> 
 <title>Janelas do Ciberespaco</title> 
</book> 
 (C) 
<book> 
 <title>Janelas do Ciberespaco</title> 
 <author> 
  <name> 
   <firstname>Andre</firstname> 

   <lastname>Lemos</lastname> 
  </name> 
  <email>alemos@yahoo.com</email> 
  <email>andre.lemos@sulina.com.br</email> 
 </author> 
 <author> 
  <name> 
   <firstname>Marcos</firstname> 
   <lastname>Palacios</lastname> 
  </name> 
  <email>mpalacios@yahoo.com</email> 
 </author> 
</book> 

(D) 
<book> 
 <title>Janelas do Ciberespaco</title> 
 <author> 
  <name> 
   <firstname>Andre</firstname> 
   <lastname>Lemos</lastname> 
  </name> 
  <email>alemos@yahoo.com</email> 
 </author> 
 <author> 
  <name> 
   <firstname>Marcos</firstname> 
   <lastname>Palacios</lastname> 
  </name> 
  <email>mpalacios@yahoo.com</email> 
 </author> 
</book> 

(E) 
<book> 
 <title>Janelas do Ciberespaco</title> 
 <author> 
  <name> 
   <firstname>Andre</firstname> 
   <lastname>Lemos</lastname> 
  </name> 
  <email>alemos@yahoo.com</email> 
 </author> 
 <author> 
  <name> 
   <firstname>Marcos</firstname> 
   <lastname>Palacios</lastname> 
  </name> 
  <email>mpalacios@yahoo.com</email> 
 </author> 
 <publisher>Ed. Olivier</publisher> 
</book> 

54 - Suponha que uma aplicação, utilizando uma 
implementação da API DOM, navegue em memória por 
uma árvore de objetos cuja raiz é um objeto document, 
gerado a partir do documento XML acima. O comando 
getNextSibling, quando aplicado sobre o objeto que 
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contém o elemento XML <xsd:element 
name="name">, retorna um outro objeto. A alternativa 
abaixo onde se encontra o elemento XML contido no 
objeto resultante é: 
 
(A) <xsd:complexType> 
(B) <xsd:sequence> 
(C) <xsd:element name="title" type="xsd:string"/> 
(D) <xsd:element name="author"> 
(E) <xsd:element ref="firstname" /> 
 
 
55 - A alternativa abaixo que NÃO exibe um trecho de 
documento XML bem formado é: 
 
(A)    <book tipo=”capadura”>O      

Alienigena</book> 
(B)    <book estilo=”romance”> 
    <tit>O Alienigena</tit> 
    </book> 
(C)    <book datapub=”21/12/1930”  
    tit=”O Alienigena” /> 
(D)    <book tipo=”ficcao”  
    tipo=”romance”>O  
    Alienigena</book> 
(E)    <book> 
         <tipo>ficcao</tipo> 
         <tipo>romance</tipo> 
    <tit>O Alienigena</tit> 
         </book> 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
56 - Uma das formas de acessar um banco de dados a partir 
de um script escrito em ASP é através da tecnologia ADO 
(ActiveX Data Objects) da Microsoft. A opção abaixo que 
contém o conjunto de comandos corretos para, usando 
ADO, efetuar uma conexão a um banco de dados 
utilizando um DSN (Data Source Name) chamado 
“BANCO”, usuário autorizado “Usuario”, e senha “senha” 
é: 

 
(A) 
Set Conn=Server.OpenDB("ADODB.Connection") 
Conn.Open "DSN=BANCO;UID=Usuario;PWD=senha" 
 
(B) 
Set Conn=Server.CreateObject("ADODB", "BANCO") 
Conn.Open "UID=Usuario; PWD=senha" 
 
(C) 
Set Conn=Server.CreateObject("ADODB.Connection") 
Conn.Open "DSN=BANCO; UID=Usuario; PWD=senha" 
 
(D) 
Set Conn=Server.CreateObject("ADODB.Open") 
Conn.Connect "DSN=BANCO; UID=Usuario; PWD=senha" 
 
(E) 
Set Conn=Server.ConnectDB("ADODB") 
Conn.Connect "DSN=BANCO; UID=Usuario; PWD=senha" 

 
 
57 - Uma das funções do programa utilitário 
IPCONFIG.EXE, quando executado com o parâmetro 
“/all” é: 
 
(A) mostrar informações detalhadas da configuração das 

interfaces de rede do computador em que ele foi 
executado; 

(B) definir e configurar os parâmetros de rede do 
computador em que foi executado; 

(C) mostrar o endereço IP e o nome de cada interface 
entre o computador cliente e o computador destino; 

(D) verificar se um outro computador está ligado e 
conectado à rede no momento da execução do 
programa; 

(E) atualizar o driver da placa de rede do computador 
em que ele foi executado. 

 
 
 
 
 
 
 
 
58 - O serviço DNS chamado de resolvedor (resolver) é 
executado no computador cliente e tem a função de: 
 
(A) mudar o IP do computador; 
(B) monitorar o tráfego de rede e melhorar sua 

performance; 
(C) verificar se o computador destino está respondendo a 

comandos; 
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(D) encontrar o endereço IP correspondente a um dado 
nome de computador; 

(E) mudar a máscara de rede do computador. 
 
 
59 - No Internet Information Server 5 a guia “Documents”, 
localizada na janela de propriedades de um determinado 
site definido neste servidor, tem a função de: 
 
(A) definir os únicos documentos deste site que o 

servidor pode mostrar; 
(B) listar todas as páginas que foram desenvolvidas em 

formato HTML neste servidor; 
(C) associar a cada página o método de acesso que deve 

ser utilizado pelo servidor; 
(D) configurar as permissões de acesso de todas as 

páginas deste site; 
(E) determinar os arquivos que devem ser procurados 

pelo servidor para ativar a página sem que seja 
citado o nome de um arquivo pelo cliente. 

 
 
60 - O protocolo DHCP (Dynamic Host Configuration 
Protocol) tem a função de: 
 
(A) habilitar a administração remota sobre o Windows 

2000 Server; 
(B) controlar a replicação entre os Controladores de 

Domínio, de forma que a rede seja utilizada de 
maneira otimizada e garantir que todas as 
informações estejam atualizadas; 

(C) permitir que endereços IP, definição de máscaras 
de subrede, entre outros parâmetros de 
configuração, sejam distribuídos dinamicamente 
para as estações de trabalho ou servidores; 

(D) compartilhar os arquivos armazenados no 
servidor, de forma que todos os usuários do 
domínio possam ter acesso a essas informações; 

(E) permitir o acesso remoto à rede corporativa da 
empresa a partir de um servidor que esteja 
configurado como roteador. 

 
 
61 - O repositório de todas as mensagens num Microsoft 
Exchange Server é denominado: 
 
(A) Message Transfer Agent (MTA); 
(B) Distribution List (DL); 
(C) Information Store (IS); 
(D) Messages Template (MT); 
(E) Mail Connector (MC). 
 

 
62 - Quando utilizamos uma URL com protocolo HTTPS, 
estamos estabelecendo uma conexão: 
 
(A) que não pode ser terminada a não ser pelo 

administrador do servidor IIS; 
(B) com um canal seguro para troca de dados entre o 

cliente e o servidor, via chaves de criptografia; 
(C) entre um servidor IIS 5.0 e um servidor Apache; 
(D) que tem uma velocidade de transmissão maior 

pelo fato de ter maior prioridade; 
(E) que só se dá, obrigatoriamente, entre um servidor 

IIS 5.0 e um browser Internet Explorer 6.0. 
 
 
63 - Um endereço IP identifica unicamente um computador 
em uma rede TCP/IP e é composto por: 
 
(A) 2 bytes; 
(B) 4 bytes; 
(C) 128 bytes; 
(D) 255 bytes; 
(E) 1024 bytes. 

 
 

64 - A ferramenta do CorelDraw que permite criar linhas 
interligadas automaticamente, apenas definindo seus nós é: 
 
(A) Dimension; 
(B) Artistic Media; 
(C) Freehand; 
(D) Bezier; 
(E) Outline Pen. 
 
 
 
 
 
 
 
 
65 - No aplicativo CorelDraw, o comando que permite 
juntar linhas criadas separadamente, de modo a unir seus 
nós é: 
 
(A) Arrange > Group; 
(B) Arrange > Order; 
(C) Arrange > Combine; 
(D) Effects > Envelope; 
(E) Arrange > Convert Outline to Objects. 
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66 - No Adobe Photoshop 6.0, o formato de apresentação 
de imagens que permite fundo transparente é: 
 
(A) TIFF; 
(B) JPG; 
(C) GIF; 
(D) BMP; 
(E) PSD. 
 
 
67 - No Adobe Photoshop 6.0, com a ferramenta de 
seleção ativada, a tecla ou combinação de teclas que 
permite acrescentar uma seleção a outra já existente é: 
 
(A) CTRL; 
(B) SHIFT; 
(C) ALT; 
(D) CTRL+SHIFT; 
(E) CTRL+ALT. 
 
 
68 - No Adobe Photoshop 6.0, o comando que permite 
alterar a resolução de uma imagem é: 
 
(A) Edit > Fill … 
(B) Image > Canvas Size … 
(C) Image > Extract 
(D) Image > Image Size ...  
(E) Image > Adjust > Auto Levels 
 
 
 
 
 
 
 
 
 
 
 
69 - O formato gráfico que NÃO é exibido pelo Flash 5.0 
ao selecionar o comando File/Export Image é: 
 
(A) MP3; 
(B) JPG; 
(C) GIF; 
(D) PNG; 
(E) WMF. 
 
 

70 - No MS Visual InterDev 6.0, ao criar um novo arquivo 
HTML, o editor de HTML apresenta algumas guias por 
padrão. A opção que mostra as guias apresentadas é: 
 
(A) Design, HTML e View; 
(B) Design, Source e HTML; 
(C) Design, ASP e HTML; 
(D) Design, View e HTML; 
(E) Design, Source e Quick View. 
 
 

 
 


